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2 Foreword 

 

Dear Customer, 

 

When using the CS Network software, you can read out our sensors directly or save a number of 
measured values from our data recorders in a central database. It is also possible to integrate 
third-party sensors, provided they have an Ethernet interface. You can then access this data from 
several clients and evaluate or display it via a user authorization concept. You can also send 
alarms and evaluations automatically by e-mail to the users via push message. 
 
In this documentation, the configuration by a user in the user interface on a PC is described. 
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3 Notes 

3.1 About this document 

• Read this documentation carefully. 

• Keep this document close at hand so you can refer to it if necessary. 

• Share this document with future users of the product. 
  

 
CS Instruments GmbH & Co.KG offers no guarantee in relation to the suitability for any other 
purpose and accepts no liability for any printing errors in this operation manual. The same applies 
to consequential damage in connection with the delivery, capacity or use of this software.  
 

4 System Requirements 

Hardware Server Platforms 
Windows Server 2016 64bit 
Windows Server 2019 64bit 

Virtualization platforms Vmware, Hyper-V, virtualBox 

Main memory requirement min. 8 GB RAM – recommended 16 GB 

Hard disk space 

min. 100 GB SSD (also depends on the measured 
values and log times) 

Example:  

Data quantity: 200 measured values x 4 bytes per value = 800 
bytes  

Log interval: 5s ≙ 17280 storage values per day (86400s per 
day / 5s log interval)  

 

Remaining storage capacity [days] = (storage capacity / data 
quantity) / storage values per day  

 

Remaining storage capacity [days] = (100,000,000,000 bytes / 
800 bytes) / 17280  

 

Remaining storage capacity [days] = 7233.796 days ≙ 19.82 
years 

 

Processors 4 CPUvCore 

Windows Clients From Win10 64bit 

 
For correct communication and operation of the software, the following ports in the network must 
be enabled: 
Port 50051 is used for communication between the Windows client and the Ubuntu server via 
gRPC. 
The server needs port 502 for communication with the devices/sensors via ModbusTCP. 
Port 8800 (server - devices/sensors) is used for the broadcast for automatic device detection. 
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5 Opening the software for the first time 
When the software is put into operation for the first time, the admin must be created. This person has all 
rights and is also intended for service cases. 
Assign a profile name and set your host name (IP address of the server). As a user, use the following data: 
 
User:  Admin 
Password:  2_cssoft!cs 
 
You can then proceed with setting up the software. 
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6 Project Data Set-up  
In the following the set-up of a project by the user is described. After the initial set-up, all steps 
can be performed again, detached from all other steps. 
 
It is important to note that a device/sensor can only be scanned in one project. A multiple scan of 
devices is not possible. We recommend to create only one project in a company or location, which 
collects the measured data of all devices/sensors over months/years. The creation of multiple 
projects can be replaced by the different areas within one project. This simplifies the maintenance 
effort and data management. 
 
After the initial set-up of the project, you have to start the project in the project overview for the 
data recording to be activated. 

6.1 User Registration and Profile Selection 

During the initial user registration, the user must create a password for his account. The password 
must be between 5 and 25 characters long. The user is free to choose the characters. Each user 
has his own password. 
 
The user will then choose the profile in which he works. The profile is created by the superadmin 
and defines the access to the server path. After that the user has access to the projects or can 
generate new ones. 
 
Using the “Settings” button takes the user to the configuration menu. In the configuration menu, 
users and projects can be created and access rights can be assigned. 

 

6.2 Creating a New Project 

In the configuration menu under "Project settings" you can change the default project. Click on 
the project in the navigation bar on the left and then on the "Edit" button. 
Enter a project name and optionally a description to clearly identify the project. 
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After the project is created, it appears in the project selection list and can be started or stopped 
from there. For the initial set-up, the steps for setting up the areas, the devices and the measured 
data are still needed. 

6.3 Set-up of Different Areas 

The project structure can now be seen in the selection list of the “Project definition” menu. 

 
To set up different areas, select the “Area” category. As default area the area “Area1” is displayed. 
You can edit this or delete it after setting up a new area.  
To create a new area, select the “New” button or click “Edit” to modify an area. Then assign an 
area name and an optional description. 

 
Once the area has been created, you can proceed to the next step. 
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7 Configuration of Devices and Measured Values 
The integration of devices and their measured values into a project by the user is described below. 
After the initial set-up, all steps can be performed again, detached from all other steps. 
 

7.1 CS Device Integration 

The integration of sensors can be done by using the “Device” item in the project structure. 

 
By clicking on the “New” button, the menu for selecting the sensor interface opens. For the 
integration of CS devices a Modbus TCP (Ethernet) interface is required. Select “Modbus/TCP” 
in the list of the device type and then the type “CS device or sensor”. By using the Autodetect 
function the CS devices can be searched for automatically in the network. To do this, click the 
“Search” button and then select the device to be integrated from the list. 

 
In the next step you assign a device name and assign the device to an area. The “Use” checkbox 
can be checked to select if the sensor is still active (checked) or deactivated. A deactivated sensor 
(example: The sensor is currently not installed because it is being calibrated or is defective) is no 
longer queried and will therefore not cause any error messages on the server. 
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You may also set the Modbus ID, the word order and the cycle time. Check whether these settings 
correspond to your device. If you have a volume flow or dew point sensor from CS, the Modbus 
ID and the Wordorder can be retrieved from the sensor via the Autodetect function (“Autom. 
Detect” button). 

 
If the devices are integrated, they appear in the device list. Next, the measured values that need 
to be recorded must be configured. 
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7.2 Integration of Third Party Sensors 

The integration of sensors can be done by using the “Device” item in the project structure. 

 
By clicking on the “New” button, the menu for selecting the sensor interface opens. For the 
integration of third party sensors a Modbus TCP (Ethernet) interface is required. Select 
“Modbus/TCP” in the list of the device type and then the type “User definition”. 
 
In the next step you assign a device name and assign the device to an area. The "Use" checkbox 
can be checked to select if the sensor is still active (checked) or deactivated. A deactivated sensor 
(example: The sensor is currently not installed because it is being calibrated or is defective) is no 
longer queried and will therefore not cause any error messages on the server. 
You may also set the Modbus ID, the word order and the cycle time. Check whether these settings 
correspond to your device. 

 
If the devices are integrated, they appear in the device list. Next, the measured values that need 
to be recorded must be configured. 
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7.3 Configuration of Measured Values for CS Devices 

The selection of the measured values per device is done via the “Measured values” category in 
the project structure. 

  
Clicking on the “New” button opens the device selection list. Select the device from which the 
measured values should be recorded. You can then distinguish between a device value or a 
virtual value. 
Device values are the measured values that are measured directly by the device. A virtual value 
can be calculated from the device values via mathematical functions. 
 
On CS devices, the Modbus registers and addresses as well as the data type can be accessed 
preconfigured. Select the corresponding measured values and click on “OK”.  
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Once all measured values have been integrated, they appear in the measured value list under 
the project structure. 

 
After this step, the configuration of the devices and measured values is completed. The program 
is restarted. 
 
Devices and measured values can be added, changed or deleted via the project structure. 
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7.4 Configuration of Measured Values for Third Party Sensors 

The selection of the measured values per device is done via the “Measured values” category in 
the project structure. 

 
Clicking on the “New” button opens the device selection list. Select the device from which the 
measured values should be recorded. You can then distinguish between a device value or a 
virtual value. 
Device values are the measured values that are measured directly by the device. A virtual value 
can be calculated from the device values via mathematical functions. 
 
For third party sensors, the configuration of the measured values needs to be done manually. To 
do this, select the device and the measured value type and enter the Modbus addresses, the data 
type, the unit and the decimal places in the next step. For the selection of the Modbus addresses, 
a block must be set up in advance. To do this, click on the “Select” button and enter the block 
name, the function code, the start address and the number of subsequent addresses in the menu 
under “New”. By using the “Log” checkbox, you select whether the data will be recorded. 
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Once all measured values have been integrated, they appear in the measured value list under 
the project structure. 

 
After this step, the configuration of the devices and measured values is completed. The program 
is restarted. 
 
Devices and measured values can be added, changed or deleted via the project structure. 
 

7.5 Creating Virtual Values 

If you select the option virtual value at the measured value configuration, the setting window 
opens. Enter the basic data, such as name, unit and decimal places. Activate the checkbox “Log”, 
so that the virtual data are stored. 
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Then you have to assign the unit values to the data values (a to e). To do this, right-click on the 
corresponding device value from the selection list and link it to a data value. It is possible to assign 
up to five data values. 

 
To create a formula, use the “Create” button and the formula editor will open. There you can enter 
your formula and use the variables a - e for the data values. You can optionally use the 
DataValues and operators from the displayed table. With “Set printout” you save the formula. 
 

 
Once the virtual measured value is set up, it appears in the measured value list in the project 
structure.  
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8 Creating Users and Access Rights 
The following describes the creation of users and their access rights in a project by another user. 
After the initial set-up, all steps can be performed again, detached from all other steps. 
 

8.1 Creating New Users 

When working with the CS Network, several users can be assigned different access rights. To do 
this, click on the “Settings” button in the start menu after logging in and then on “User settings”. 
The user overview opens. Here you can create new users or edit or delete existing users. 
 

 
Create a new user via the “New” button, enter the data and assign it to a company/location. The 
user appears in the user list. 
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8.2 Assigning Access Rights 

By assigning access rights, you are able to give the user read or write access to different areas. 
To do this, click on the “Settings” button in the start menu after logging in and then on “User 
settings”. The user overview opens. In the “Access rights” category, assign new rights to the 
users, edit or delete them. 

 
 
Assign the rights to a project (1). Then select the user (2) + (3) and assign the corresponding 
rights (4). 
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Once the rights have been assigned to the user, this user appears in the “Access rights” overview. 

 
This enables you to individually assign access rights to different users. 
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8.3 Assigning data accesses 

Via the category "Data access" you can control the access of users to different data. In this way, only the 
data assigned to each user is visible. 

 
Data accesses refer to the modules Areas, Overviews and Analysis.  
To assign access releases, proceed as follows: 
First select the module and then the subcategory. Allow access via the checkbox in front of the user. If the 
checkbox is ticked, the user has access to the data.  
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8.4 Change User 

The status bar shows the user currently logged in. Click on the user to change the user.  

 
The profile selection screen appears. By clicking on "Modify", another user can log in. 
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9 Overviews 
The purpose of overviews within the CS Network is the graphical display of measured values on 
a central dashboard. Overviews can be customized to better display or monitor areas within a 
project. Multiple overviews can be created within a project. 
 

9.1 Creating Overviews 

To create or edit an overview, a user must activate the “Design” icon in the quick access toolbar. 
By right-clicking on the overview and then using the “Settings” tab, the name and description of 
the overview can be changed. 

 
In the designer mode the ToolBox opens. Starting from there, various preconfigured components, 
shapes and data boxes can be inserted into the overview via drag & drop. 
Your individual images can be uploaded via the “User definition images” icon in the shortcut.  
 

Through the “Style settings” in the quick access toolbar, the data boxes can be individually 
designed and predefined. User-defined images can be loaded into the software via the 
corresponding icon in the quick access toolbar.  
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9.2 Assigning Measured Values in the Overview 

Drag and drop one of the data boxes into the overview and edit it via a right click and the “Settings” 
tab. Here you can change the colour as well as the text. Assign a name in the “Part name” field 
and select the corresponding measured values under “Display values” by double-clicking on the 
value. 

 
The data box is now linked to the measured value and displays the measured value in the 

overview. 
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10 Data Evaluation 
Via the shortcut “Data” you are able to evaluate data of a certain period graphically as well as in 
tabular form. You can also display the real-time data of the devices can be in a graphic. 
 

10.1 Evaluation of a Specific Period 

Activate the graphical evaluation in the “ChartExplorer” by double-clicking on the corresponding 
measured value. The settings window appears. Here you can define the display settings of the 
measured value curve.  

 
Then in the “ChartExplorer” select the period from which the data should be analysed. You can 
choose between a specific day, a specific calendar week, a specific month or a user-defined 
period. Then confirm the period by clicking the “Apply” button. 
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In the “Statistics” tab, the software automatically determines the statistical values for the activated 
measured values in the selected period.  

 
Via the “Table View” tab, the recorded raw data per activated measured value in the selected 
period can be viewed. 
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10.2 Real-Time Data 

If you would like to record real-time data, activate the appropriate measured values in the 
“DiagramExplorer” by double-clicking and select “Real-time data” for the time period. Now you 
can define the scaling of the X-axis in seconds and the real-time data will be displayed graphically. 
 

 

10.3 Saving Measurements 

If you want to save your measurement, you can do this via the shortcut “Measurements” under 
the button “Add”. Give your measurement a name and optionally a more detailed description. You 
can then access your measurements at any time via this shortcut. 
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10.4 Export of Measurements 

To export your measurements, statistics or raw data, click on the “Print” icon in the quick access 
toolbar and select the time period from which the data should be exported. If you have previously 
selected a user-defined period, use the “Current” category. 
In the preview that opens, click on the Export icon and select the desired file type. 
 

If you want to export the data of a real-time measurement, you have to save it in advance under 
“Measurements”. 
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11 Alarms 
Below is a description of how to create alarms and how to have individual alarm messages sent 
to you by e-mail. 
You can see the alarm messages in your overview. If an alarm is triggered, the corresponding 
data box turns red and an alarm message appears. Furthermore, you can see the currently 
pending alarms as well as a history in the quick access toolbar under the category “Alarms”. 
 

11.1 Setting Up Alarms 

Alarms can be set up in the “Home” menu and then in the “Alarm Definition” category. In the 
window that appears afterwards, you will find an overview of all active and inactive alarm 
thresholds and the corresponding message. Via “Add” you can set new alarms. 

 
First select under “Alarm type” the condition that should apply and then under “Threshold”, the 
threshold value when the alarm is triggered. You can also set a delay that determines how long 
the threshold value must be violated before the alarm goes on (tOn) or off (tOff). Next, assign the 
alarm to the corresponding measured value under the “Show values” button and a predefined text 
will appear in the “Alarm text” field. You can edit this text by using the checkbox “User defined 
text”. 
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11.2 Setting up E-mail Dispatch for Alarms 

If you not only want to see your alarm messages visually in your overviews, but also want to be 
notified by e-mail, you can set up automated e-mail dispatch under the Home menu in the “E-mail 
recipients” category in the Alarm tab. To do this, activate the “E-mail active” checkbox in the 
“Settings for e-mail recipients” menu. 

 
Then select the alarm message that is to be sent by e-mail. A mask opens where all users appear. 
Now you can activate the e-mail dispatch to the user or the entire company via the checkbox. If 
the notification has to be sent to a person who is not a user of the CS Network, enter the 
corresponding e-mail of the person under “User def”. To do this, open the “Add” tab by right-
clicking in the table. 
 
Use the “Test mail” button to test the e-mail sending. 
 

11.3 Acknowledging Alarms 

After fixing the errors that triggered the alarms, you need to acknowledge the alarm messages. 
To do this, select the relevant alarm message in the quick access toolbar under “Actual Alarms” 
and then click “Acknowledge”. The alarms are moved to the “Alarm History” and can be retrieved 
there at any time. 
 

The alarm history can also be found in the “Actual Alarms” category under the “Alarm History” 
tab.  
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12 Analyses of Consumptions 
Using the CS Network, you can have automated reports issued to keep an eye on consumption 
at all times. 
 

12.1 Setting up an Analysis 

You create consumption analyses in the home menu in the category “Analysis Definition”. Use 
the “Add” button to create new analyses and there you will also find a complete overview of the 
analyses already created. 

 
Then enter the data for the analysis to be created and select the report type. You can also define 
layers to allow you to compare them with each other.  

 
The following report types are preset: 
 
Weekly report: 
The weekly report is sent to you daily. It lists each day cumulatively. 
 
Monthly report: 
The monthly report is sent to you weekly. It lists each week cumulatively. 
 
Annual report: 
The annual report is sent to you monthly. It lists each month cumulatively. 
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Select the corresponding measured values that need to be included in the evaluation. Here you 
have to select the measured value and the corresponding cumulative value. 

 
Use the “Select” button to select a tariff to determine the price per unit. If no tariff is stored yet, 
you can also insert a new tariff there. 
 

12.2 Setting up E-mail Dispatch of Analyses 

Set-up the automated e-mail dispatch under the Home menu in the category “E-mail recipients” 
in the Analysis tab. To do this, activate the “E-mail active” checkbox in the “Settings for e-mail 
recipients” menu. 
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Then select the analysis that is to be sent by e-mail. A mask opens where all users appear. Now 
you can activate the e-mail dispatch to the user or the entire company via the checkbox. If the 
notification has to be sent to a person who is not a user of the CS Network, enter the 
corresponding e-mail of the person under “User def”. To do this, open the “Add” tab by right-
clicking in the table. 
 
Use the “Test mail” button to test the e-mail sending. 
 

12.3 Retrieving Analyses 

In the quick access “Analysis” under the tab “Summary” you will find all reports that have ever 
been generated. You can retrieve them at any time by double-clicking on them. 
 

12.4 Creating an analysis for an individual period 

If you would like to create an analysis for an individual period, you must first set it up as described. 
Then you can create an analysis via the “New icon” in the quick access. To do this, select the 
analysis template, the time period and the analysis type. Then click on “Create” and the report 
will appear in your summary. 
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12.5 Comparing Analyses 

To compare different time periods directly with each other, go to the “Compare” tab via the access 
“Analysis”. The prerequisite is that you have defined analyses beforehand, as described above. 
 

Then select the corresponding analysis, the comparison type and the duration. After that, use the 
“Add” button to define the comparison periods. Use the “Compare” button to start the comparison 
and the corresponding diagrams and statistics tables will appear. 
 


